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General Information 
 

Welcome 
 

Welcome to the Scia Engineer v15 ACI Concrete Frame Tutorial. Scia Engineer is a design program in Windows with a broad application 

field: from checking/designing simple frames to the advanced design of complex projects in steel, concrete, cold formed steel and a 
variety of other materials. 

The software allows engineers to model 2D and 3D structures which include flat or curved plates and beam members (straight or  

curved) as well as other advanced 3D geometry.  The complete calculation and design process has been integrated into one program 

so that the input of geometry, input of calculation information (loads, combinations, and supports), linear and non-linear calculation, 
output of results, reinforcement design according to various codes and the generation of the calculation documentation are all completed 
in the same software. 

Scia Engineer is available in three different editions all which require a license to operate: 

- Concept 

- Professional 

- Expert 

License version  

A licensed version of Scia Engineer is secured with either a ‘dongle’, which you apply to the USB port of your computer or a software 

license on your company’s network. 

Scia Engineer is also modular and consists of various modules. The user chooses from the available modules and composes a custom 

design program, perfectly tuned to the desired needs of the company. 

In the general product overview of Scia Engineer you will find an overview of the different modules that are available.  

 

Demo version  

If the program doesn’t find a license on your computer, it will automatically start the demo version. The properties of the demo version 

are: 

- All projects can be inserted however projects created in a demo version cannot be opened in a licensed version. 

- The calculation is restricted to projects with 25 elements, 3 plates/shells and two load cases 

- The output contains a watermark “Unlicensed software” 

Scia Engineer Support 
If you need assistance with the software, you can contact the Scia Engineer support service in the following manners: 

By e-mail 

Send an e-mail to support@scia.net with a description of the problem and the concerning *.esa file, and mention the number of the 

version you are currently working with. 

By telephone 

 From USA: 443-542-0637 

Via the Scia Support website 

http://www.scia-online.com/en/online-support.html 

Website 
Link to Tutorials  

http://www.Scia-online.com > Support & Downloads > Downloads > input e-mail address > Scia Engineer > Scia Engineer 

Manuals & Tutorials 

Link to eLearning 

 http://www.scia-online.com > Support & Downloads > eLearning 

Link to Demo version 

http://www.Scia-online.com > Support & Downloads > Secured Downloads > input username and password > Service Packs > 

Scia Engineer > Setup – Scia Engineer 

mailto:support@scia.net
http://www.scia-online.com/en/online-support.html
http://www.scia-online.com/
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Introduction 
 

This tutorial describes the main functions of Scia Engineer 15, the input of design data and calculation of a 2D concrete frame.  

 

The tutorial will begin with the creation of a new project and the modelling of the concrete frame structure. After the input of all frame 
geometry and loads, the structure will be calculated and the results will be viewed.  Next, the input of the slenderness and buckling 

parameters of the frame will be discussed, followed by the concrete calculations which contain the inclusion of longitudinal, transverse 
and additional reinforcement.  Lastly, the tutorial will discuss how to format a calculation document while properly displaying the 
calculation results. 

 

The figure below shows the computational model of the structure that will be completed through this tutorial (the units are in the Imperial 

system, e.g. kips, inch): 
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Getting started 

Starting a project 

Starting the program 

Before you can start a project, you need to start the program first. 

 

1. Double-click on the Scia Engineer shortcut in the Windows Desktop. 

Or: 

2. If the shortcut is not installed, click [Start] and choose Programs > Scia Engineer 2013.1 > Scia Engineer 2013.1. 

 

If the software cannot locate a license file, you will receive a dialogue box indicating that no license was found.  A second dialogue 

box will then list the restrictions of the demo version.  Click [OK] in both windows. 

 

For this Tutorial, you must start a new project. 

 

Starting a new project 

 

1. If the program shows the Open dialogue box, click [Cancel]. 

2. Click the New icon  in the toolbar.  

 

 

 

In the Select New Project dialogue box, choose the Analysis environment by clicking on the corresponding icon. Confirm your 

choice by clicking [OK]. 

Now, the Project data dialogue box is opened.  Here, you can enter general data about the project. 
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3. In the Basic Data group, enter your preferred data.  The data you enter will be displayed on the output produced by Scia 

Engineer, e.g. in the document and on the drawings. 

4. Choose the Project level: Advanced and Model: One. 

5. Click on the rectangular button    below National Code to choose the default code for the project.  This code will 

determine the available materials, combination rules and code checks.  For the tutorial we will choose IBC (International 
Building Code). The window Codes in project is opened. 

 

- Click [Add]. 

- The dialogue box Available national codes are opened. 

- Select the USA flag and click [OK]. 

- You will return to the Codes in project dialogue and IBC is added. 

- Select the flag named IBC. 

- Select the Active code option and click [Close]. 

- You will return to the Project data window and IBC is the active code. 

 

6. Select Frame XZ in the Structure field. 

The structure type (Frame XZ, Frame XYZ, Plate XY, General XYZ, etc.) will restrict the input possibilities during the 

calculation. 

 

7. In the Material group, select Concrete.  Below the item Concrete, a new item Material will appear. 

 

8. Choose C4000 from the menu.  This choice corresponds with the compressive design strength of the concrete. 

 

9. Confirm your input with [OK]. 

 

10. On the Code Setup tab, you can see the specific codes that are used for the generation of loads and the design of steel, 

concrete and cold formed steel structures.  In addition to these codes, you can also choose the measurement system and 
formatting that will be used throughout the project.  

11. Click on Code Setup tab and click on the  button beside Code setup.  Now, the Format and measuring system 
dialogue box is opened. Choose Imperial format and click [OK]. 
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Notes: 

On the Basic data tab, you can set a project level.  If you choose “standard”, the program will only show the most frequently used 

basic functions.  If you choose “advanced”, all basic functions will be shown.   
On the Functionality tab, you choose the options you need.  The non-selected functionalities will be filtered from the menus, thus 
simplifying the program and the analysis.  

On the Load tab, you will find the value for the acceleration of gravity and the applicable wind and snow loads that can be activated 
with the Climate loads functionality. 
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Project management 
 

Save, Save as, Close and open 
 

Before entering the software to complete the frame construction, we will first discuss how to save a project, how to open an existing 

project and how to close a project. While completing the tutorial, the project can be saved at any time, that way you can leave the 
program at any time and resume the project from the save location later. 

 

Saving a project 

Click on   in the toolbar. 

 

If a project has not yet been saved, the dialog box Save as appears. Navigate to the location or the drive where you want to save 

your project in. Select the folder or subfolder in which you want to save the project and enter the project file name in File name field.  
Once this is complete click on [Save] to save the project. 

If you press  twice, the project is automatically stored with the same name. If you choose File > Save as in the main menu, you 

can enter a new file name or save location for the project file.  

 

Closing a project 

 

To close a project, choose File > Close in the main menu. 

 

A dialog box appears asking if you want to save the project. Depending on your choice, the project is saved and the active dialog box 

is closed. 

 

Opening a project 

Click on    to open an existing project. 

 

A list with Scia Engineer projects appears. Select the desired project and click [OK] (or double-click on the project to open it). 
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Units 

Changing the units 
At the beginning of a new project, verify that the units used by Scia Engineer are compatible with your desired units. To check and 

modify the units: 

1. Click on Setup in the main menu and select Units. 

 

 
 

 
2. In the Units window you can view the units for different options and modify them to your desired unit system. 

    

 

 

Note: 

It is possible to create a default template file that contains user preferences for desired units, scales and fonts.  A template file can be 

created and saved so that the user can load the desired template file before beginning a new project.  The creation and use of 

template files is not discussed in this tutorial.  
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Geometry input 

 
Input of the geometry 

When starting a new project, the specific geometry of the structure must be entered.  The structure can be entered directly, or it is 

possible to add geometry using instance templates with parametric blocks, DXF files, DWG files and other formats. 

Profiles 

When entering one or more 1D structural elements, a profile type is immediately assigned to each member.  By default, the active 
profile type is represented.  At any time it is possible to open the profile library to activate another profile type.  If you want to add a 

structural part before a profile type has been defined, the profile library will automatically be opened. 

 

Adding a profile 

1. Click on the Cross-Sections   icon in the toolbar. 

 
The Cross-Section manager is opened. If no profiles have been entered in the project, the New cross-section window 

will be automatically opened. 
 

            

 

2. Click Concrete in Available groups. 

3. In the Available items of this group, you can choose a rectangular section  . 
 

4. Click [Add] or   to add the profile to the project. After adding, the Cross-Section window appears. 
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5. In this window, you can change the properties of the rectangular section. Enter 20 inch for height H and 20 inch for width 

B. 

6. Click [OK] to confirm, the profile is added to the Items in Project group. 

7. A second rectangular section with height H = 28 inch and width B = 18 inch is added in a similar way. 

8. Click [Close] in the New Cross-Section window, the Cross-Sections Manager appears. 

9. Click [Close] to close the Cross-Section Manager and to return to the project. 

Geometry 

Structure menu 

1. When a new project is started, the Structure menu is automatically opened in the Main window. If you want to modify the 
structure at a later time, you must double-click on Structure in the Main window to activate the menu. 
 

                               

   

2. In the Structure menu, you can choose different structural elements to enter into the structure. 

 

To model the frame, you first must enter the columns.  After the columns have been entered, the beams on top and in the middle of the 

columns can be entered. 
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Entering a column 

1. Use the Column option in the Structure Menu to enter a new column. 
 

               

 

2. In the Cross-section field, choose the concrete section CS1 – Rectangle (20.000; 20.000) 

3. Specify the column length as 276 inch or (23’-0”). 

4. The insertion position is by default set to Bottom so that the bottommost point determines the position of the column. 

5. Confirm your input with the [OK] button. 

6. The first column in the frame is positioned at the origin of the coordinate system. To accomplish this, you must enter the 

coordinates 0, 0 in the Command line and then press <Enter> to confirm your input. 

 

7. A second column is entered in a similar way at position 240,0 or (20’, 0’) 

8. End the input using the <Esc> key. 

9. After input of an entity in Scia Engineer, the entity is always selected.  In this instance, the columns are colored magenta meaning 

they are the active selection.  To cancel the selection, press the <Esc> key once more. 

 

Notes: 

The properties of selected elements are shown and can be modified in the Properties window.  If no section has been defined in the 

project, the New cross-section window will automatically appear as soon as you try to enter a structural element (column, beam, 
brace, etc.).  At any time, you can end your active input by pressing either the <Esc> key either the right mouse button. 
 

To quickly visualize the entire structure, click Zoom All  in the toolbar. 

 

When entering coordinates using the command line, separate the desired coordinates using either a comma (,) or a space.  

 

When both columns are entered into the model, you can start adding the beams to the frame.  The start and end points of the beams 

are already known, i.e. the center and the end point of the column.  Therefore, the beams will not be entered through coordinates, but 
using the Cursor Snap Settings. 
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Cursor snap settings 

1. Click on the Cursor snap settings icon  in the Command line or click on the button  at the lower 
right of the screen. The Cursor snap settings window is opened. 
 

2. Activate the options a) and b) to select the midpoints and the end points of members as snap points in this project. 
 

3. Click [OK] to confirm. 

 

         

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

 

Now, you can enter the concrete beams. 

 

Entering a beam 

1. To enter a new beam, you use the Beam option in the Structure menu. 

 

2. In the Cross-section field, choose the second section CS2 – Rectangle (28.000, 18.000) 

 



Tutorial Frame concrete 

 

16 

 

3. Enter the beam length as 240 inch or (20’-0”). 

4. The insertion position is by default set to Begin so that the left point determines the position of the beam. 

5. Confirm your input with [OK]. 

6. Now click with the mouse on the center of the left-hand side column to enter the beam: 

 

7. The upper beam is entered in a similar way by clicking the top node of the left-hand side column. 

8. Press <Esc> to terminate the input. 

9. Press <Esc> once more to cancel the selection. 

Hinges 

In this project, the beams are connected to the columns in a hinged manner.  Since the structure type has been chosen as Frame XZ, 
by default the members will be connected to each other with fixed ends.  Because of this, hinges must be manually added to the 
frame. 

Entering hinges 

1. To enter hinges, use the Model data > Hinge on beam option in the Structure menu. 
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2. The hinges are needed at both the beginning and the end of the beam, therefore the Both is selected as the Position of the 

hinge. 

3. To obtain a hinge, the rotation fiy is taken Free, while the translations remain Fixed. 

4. Confirm your input with [OK]. 

5. The hinges are added by clicking with the left mouse button on both the top and bottom beams. 

6. Press <Esc> to terminate the input. 

7. Press <Esc> once more to cancel the selection.  

 

 

Supports 

The geometry input can be completed with supports.  Both column bases are modelled as fixed supports. 

Entering supports 

1. To enter supports, use the Model data > Support > in node option in the Structure menu. 
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2. To model the ends as fixed, the Constraint is set to Rigid.  This will set the rotation of the support in the applicable directions 

based on the structure type of the project (Frame XZ) to Rigid. 

3. Confirm your input with [OK]. 

4. To specify support type on the frame, simply select both bottom nodes by drawing a box with the mouse from the left-hand 

side to the right-hand side: 

 

5. Press <Esc> to terminate the input. 

6. Press <Esc> once more to cancel the selection. 

 

 

 

Notes: 

If you draw the box from the left-hand side to the right-hand side, only entities, which are completely in the rectangle, will be selected.  

If you draw the rectangle from the right-hand side to the left-hand side, the entities, which are completely in the rectangle, as well as 
the entities that intersect with the rectangle will be selected. 

 

The Command line includes a number of predefined supports.  For this project, you could also have used the Fixed Support   
icon. 
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Check Structure data 
After input of the geometry, the input can be checked for errors by means of the option Check Structure data. With this tool, the 

geometry is checked for duplicate nodes, zero beams, duplicate beams, duplicate hinges and duplicate supports. 

Checking the structure 

1. Double-click on the Check Structure data option in the Structure Menu or click on the   icon in the toolbar. 
 

2. The Structure data check window appears, listing the different available checks. 
 

               

 

3. Click [Check] to perform the checks. 

 
4. The Data Check Report window appears, indicating that no problems were found. 

 

                             

 

5. Close the check by clicking [OK]. 

Connecting entities 

The start and end node of the top beam is an end node of a column.  Therefore, this beam is automatically connected to the columns. 

The beam in the middle of the columns, however is not connected at a column end node.  The end nodes of the beam are located at 

some internal point within the column and therefore are not yet connected to the columns.  In this paragraph, we will explain how to 

connect the members to each other. 

To display the names of the bars and nodes, you can activate the labels by means of the buttons in the Command line. 

Activating node labels 

 Node labels are activated by means of the   icon on top of the Command line. 
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Activating member labels 

 Member labels are activated by means of the  icon on top of the Command line. 

 

 

 

 

When you select column B1 with the left mouse button, the properties are displayed in the Property Window: 

 

 

 

This window indicates that the begin node is N1 and the end node N2. Node N5 is not part of the column.  To connect beam B3 to the 

columns, you must use the option Connect members/nodes. 
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Connecting entities 

1. Press <ESC> or click the Cancel selection  icon to deactivate any selection of entities. 
 

2. Double-click on the Model data > Connect members/nodes option in the Structure menu or click the   icon in the 
toolbar. 

 
3. A dialogue box appears asking if all nodes should be connected. 

 

                  

 

4. Click [Yes]. 

 

5. The Setup for connection of structural entities dialogue box now appears. 

 

                 

 

 

6. Confirm the settings by clicking [OK]. 

 
7. A window appears to indicate the number of connected nodes: 

 

                  

 

8. Connected nodes are represented in the graphical screen by means of double red lines: 
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If you select beam B3, the Property Window will show that node N5 connects the beam to column B1 and that node N6 connects 

the beam to column B2. 

 

 

 

        

 

Note: 

If a possible active selection is not deactivated when the Connect members/nodes command is used, the program will only search 

the nodes to be connected in this selection and not in the entire project.  

It is also possible to perform the two previous operations at once. To do this you have to select the option Check (merge duplicate 

nodes, erase invalid entities) in the Setup for connection of structural entities dialogue box. 

 

9. Click [Close] at the bottom of the Structure menu to return to project view. 
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Graphical representation of the structure 
 

Edit view 

 

Within Scia Engineer there are several possibilities to edit the graphic representation of the construction. Below you will find the most 

important options: 

 

- Edit the view point on the Construction 
 

- Set a view direction 
 

- Use the magnifier 

 
- Edit view parameters through the menu View parameters 

 

Editing the view point on the construction 

 

One of the methods for editing the view point of the structure is through the three wheels in the bottom right of the graphic window; 

two are horizontal and one is vertical. With these wheels you can zoom in on the construction or turn it.  

 

1. To zoom in on the construction or to turn the structure, click on the appropriate wheel (the cursor will change into a hand), 
keep the left mouse button pressed and move the wheel 
 

OR 
 
Set the view point by combining the buttons and mouse.  

 

2. Press CTRL + right mouse button at the same time and move the mouse to turn the construction. 

 

3. Press SHIFT + right mouse button at the same time and move the mouse move the construction. 

 

4. Press CTRL + SHIFT + right mouse button at the same time and move the mouse to zoom in or out on the construction. 

 

Note: 

If the structure is being turned while a node is selected, the structure will turn around the selected node. 

 

Setting a view direction with regard to the global coordinate system 

1. Click on the button View in direction- X  for a view the structure in the X-direction. 

 

2. Click on the button View in direction- Y  for a view the structure in the Y-direction. 

 

3. Click on the button View in direction- Z  for a view the structure in the Z-direction. 

 

The magnifier 

 

- Use  to enlarge the view size. 

 

- Use  to decrease the view size. 
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- Use  to zoom in on a window. 

 

- Use  to view the whole structure. 
 

- Use  to zoom in on the selection. 
 

Editing view parameters through the menu View parameters 

 

1. Click in the graphic window on the right mouse button. The following shortcut menu appears: 

 

                            

 

Note: 

If an element was selected previously, you can define a setting that only applies to the selected elements. (An adapted shortcut menu 

appears). 

 

 

2. Choose the option Set view parameters for all. The window View parameter setting appears. The menu consists of 

various tabs. You can set the view parameters for all entities or just for the selected entities. 

View parameters – Entities 

 

 Through the tab entities the representation of the different entities can be adapted. 

 

 In the group Structure the following items are important for this project: 

 

- Style and color: You can display the colors per layer, material, cross-section or structural type. 
 

- Draw cross-section: With this the symbol of the cross-section is displayed on every member. 
 

- Local axes: With this the local axes of the elements are activated. 
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View parameters – Labels and description 

 

Through the tab Labels, the labels of different entities can be displayed. In the group Members the following items can be displayed 

as a label on the structure: 

 

- Name: Show the name of the cross-sections in the label. 

 

- Cross-section type: Show the cross-section type in the label. 

 

- Length: show the length of the member in the label. 
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View parameters – shortcuts 

 

In the tool bar above the Command line, several frequently used options are grouped among which: 

 

- Show/hide surfaces  to show the surfaces of the cross-sections. 

- Render geometry to view the rendered members in the structure. 

 

- Show/hide supports  to show supports and hinges. 

 

- Show/hide load to show the load case. 
 

- Show/hide other model data   to show other model data (like hinges, internal nodes, etc.) 

 

- Show/hide node labels  to view the label of the nodes. 

 

- Show/hide member labels  to view the label of members. 
. 

- Set load case for view  to edit the active load case. 
 

- Fast adjustment of view parameters on the whole construction  to quickly access the options from the View 

Parameters menu. 
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After rendering, the following structure is obtained (AXO view): 
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Loads and combinations 

Load Cases and Load Groups 
 

Each load that is inserted into the project and added to the structure is attributed to a load case.  A particular load case can contain 

many different load types. 

Each load can is attributed properties which will determine the proper generation of load combinations.  In addition, a specific load 

case will carry a specific action which can be set as permanent or variable. 

In the case of variable load cases, each variable load has its own associated load group.  The group contains information about the 

category of the load (service load, wind, snow, etc.) and its appearance (default, together, exclusive).  In an exclusive group, the 

different loads attributed to the group cannot act together in a normal combination.  Default combinations, on the other hand, will 
allow for simultaneous action of the loads in the same group within the load combination generator. 

The way in which load cases are defined, is critical for the load combinations created by the generator.  We recommend that you 

thoroughly read the chapter about loads and combinations in the reference manual found in the Help menu. 

In this particular project, three load cases are entered: 

 

- LC1: Permanent Load Case: Self weight of the concrete members  

- LC2: Permanent Load Case: Weight of the Floor and Weight of the Roof (Superimposed Dead Load) 

- LC3: Service Load Case: Service load on the Floor (Live Load) 

 

Defining a Self Weight Load Case 

1. Double-click on in the Main window. 

 

2. Before you can define loads, you first must enter load cases.  Since this project does not contain any load cases yet, the 
Load Cases Manager will automatically appear. 
 

3. By default, load case LC1 is created.  This load is a permanent load of the Self Weight load type.  The self weight of the 
structure is automatically calculated by means of this type. 
 

4. In the Description field, you can describe the content of this load case.  For this project, enter the description “Self 
Weight”. 
 

                

 

Defining a Permanent Load Case 

1. Click  or  to create a second load case. 

 
2. Enter the description “Superimposed Dead”. 
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3. As this is a permanent load, change the Action type to Permanent. 

 
4. Verify that both LC1 – Self Weight and LC2 – Superimposed Dead are in the LG1 LoadGroup. 

 

 

 
 

Defining a Variable Load Case 

1. Click  or  to create a third load case. 

 
2. Enter the description “Service Load”. 

 

3. As this is a variable load, change the Action type to Variable. 
 

 

 

4. The LoadGroup LG2 is automatically created.  Click    to display the properties of the LoadGroup. 



Tutorial Frame concrete 

 

30 

 

 

The IBC load type determines the load factors that are attributed to the load cases in this load group.  In this project, choose L-live 

load. 

 

5. Click [OK] to close the Load group manager and to return to the Load cases manager. 

         
6. Click [Close] to close the Load cases manager. 

 

Note:  

Load groups 

Each load is classified in a group.  These groups influence the combinations that are generated as well as the code-dependant 

factors to be applied.  The following logic is adopted throughout the software: 

Variable load cases that are independent from each other are associated to different variable groups.  For each group, you set the 

load category (see ASCE 7) and the combination factors from the American Concrete Code (ACI 318) are generated from the 
available load groups.  When a generated combination contains two load cases belonging to different groups, reduction factors will be 

applied for the transient loads.  

If the load is divisible, its different components are entered as individual load cases. As long as the load combination does not contain 

any variable load belonging to another group, no reduction factors will be applied.  The different load cases of a divisible load are 
therefore associated to one variable group.  

Load cases of the same type that may not act together, are put into one group, which is made exclusive, e.g. “Wind X” and “Wind -X” 

are associated to one exclusive group “Wind”.   

Loads 
After the input of the Load cases, the Loads menu will automatically appear: 

The first load case (LC1) includes the self weight of the concrete members.  As can be seen in the Loads menu, self weight is 

automatically accounted for and no point or line loads need to be added to the frame.  The self weight is added to the structure based 
on the geometry and material properties of the sections. 
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Switching between load cases 

Activate LC2 by selecting this load case with the mouse pointer in the list box: 

 

                   

 

Once you have switched load cases, the floor and roof superimposed dead loads can be entered as a series of concentrated loads on 

the structure. 

Entering a series of concentrated loads  

1. Click on Point force on beam in the Loads Menu. The dialogue box Point force on beam appears. 
 

 

2. The floor beam is loaded with 6 concentrated loads of 5.6 kips with a spacing of 40 inches. The first concentrated load in the 

series is at 20 inch from begining node of the beam. 

3. The Value of the concentrated load is changed to –5.6 kips. 

4. The coordinate definition is set to Absolute. 

5. The starting position, Position x is changed to 20 inch. 

6. The series consists of 6 concentrated loads, therefore set the Repeat (n) to 6. 

7. The spacing, Delta x between the concentrated loads is 40 inch. 
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8. Confirm your input with [OK]. 

9. Select beam B3. 

10. Press <Esc> to terminate the input. 

11. Press <Esc> once more to cancel the selection. 

 

The roof beam is similarly loaded with concentrated loads of 2.8 kips. To complete this task, it is possible to copy the load from the 

floor beam to the roof beam and adapt it accordingly. 

 

Note:  

Loads, supports and hinges are considered as additional data, i.e. data that are additionally added to entities such as nodes and 

beams. 

Copying loads 

1. Select one of the concentrated loads on the floor beam with the left mouse button. As this concentrated load is part of a 
series, the entire series is automatically selected. 

2. Press the right mouse button to display a popup menu: 

 
 

3. Choose the option Copy add data F1. 

4. Select the beam where this load should be copied to: the roof beam B4. 

5. Press <Esc> to terminate the input. 

6. Press <Esc> once more to cancel the selection. 

 

Use the   Quick adaptation of view parameters on the entire construction icon on top of the Command line to activate 
the Labels of Loads option in the Loads/Masses group.  A normal load is represented in green. 

Now, the value of the roof load can be changed. 

Adapting a load 

1. Select one of the concentrated loads on the roof beam. As this concentrated load is part of a series, the entire series is 
automatically selected. 

2. The properties of the series are displayed in the Property Window. 

3. Change the value from –5.6 kips to –2.8 kips. 

4. Confirm the change by pressing <Enter>. 
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After input of the loads in the LC2 load case, you can enter the service load, LC3 on the floor beam of -0.7 k/ft. 

Entering a linear load 

1. Click on Line force – on beam in the Loads Menu. The dialogue Line force on beam appears. 

2. Change the type to Force and the value to -0.7 kip/ft. 

3. Confirm your input with [OK]. 

 

4. Select the beam on which this load must be positioned: floor beam B3. 

5. Press <Esc> to terminate the input. 

6. Press <Esc> once more to cancel the selection. 

7. Click [Close] to leave the Loads Menu and to return to the Main Window. 

                 

Note: 

The Command line includes a number of predefined loads:  which enable the fast and simple input of 

loads. 
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Combinations 
After input of the load cases, the latter can be grouped in combinations. In this project, two linear combinations are created, one for 

the Ultimate Limit State (LRFD – Ultimate) and one for the Ultimate Serviceability State (LRFD – Service). 

Defining Combinations 

1. Double-click on  below  in the Main window. 

 

 
 

2. Since no combination has been entered yet, the window to create a new combination will automatically appear.  
 

 
 
 

3. The Type of the combination is changed to IBC (LRFD) - ultimate. With this combination type, Scia Engineer will 
automatically generate combinations in accordance with the complex composition rules of the ACI. 
 

4. By means of the button [Add all], all load cases can be added to the combination. 
 

5. Confirm your input with [OK]. The Combination Manager is then opened. 

 

6. Click   or   to create a second combination. 
 

7. Change the Type of the combination to IBC (LRFD) - serviceability. 

 
8. Confirm your input with [OK]. 

 

9. Click [Close] to close the Combination manager. 
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Calculation 

Linear Calculation 
If the calculation model is ready to be analyzed, it is then time to run the calculation of the frame and retrieve results. 

Executing the Linear Calculation 

1. Double-click on   below  in the Main window. 

 
2. The FE Analysis window appears. Click [OK] to start the calculation. 

 

 

 

3. After the calculation, a window announces that the calculation is finished and the maximum deformation and rotation for the 

normative load case is shown. Click [OK] to close this window. 
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Results 

Viewing results 
After the calculation is executed, the results of the loading on the frame can be viewed. 

Viewing the Reaction Forces 

1. Double-click on  in the Main window. The Results menu then appears. 

 
2. Below Supports, click Reactions. 

 

3. The options in the Property Window are configured in the following way: 
 
- The Selection field is set to All. 

 
- The Load type is set to Combinations and the Combination to ULS. 

 

- The Values are wanted for Rz. 
 

- The Extreme field is changed to Node. 

 

 
 

4. The action Refresh has a red background, i.e. the graphical screen must be refreshed.  Click on the   button 
behind Refresh to display the results in the graphical screen in accordance with the set options.  
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5. To display these results in a table, the Preview action is used.  Click on the  behind Preview to open the 
Preview.  

 

Note:  

The Preview appears between the Graphical Screen and the Command line. This screen can be maximized to display more data at 

any time. 

Viewing internal forces on beam 

1. In the Results menu, open the Beams group and select Internal forces on beams. 

2. The options in the Property Window are configured in the following way: 

 The Selection field is set to Current. 

 The Load type is set to Combinations and Combination to ULS 

 The Values are wanted for My. 

  The Extreme field is changed to Member. 
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3. Select the two beams B3 and B4 using the left mouse button. 

4. Click on the  button behind Refresh to display the results on the graphical screen in accordance with the set 

options. 
 

 

 

 

To change the display of the results, the settings of the Graphical Screen can be adapted. 
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Configuring the Graphical Screen  

1. In the Properties window, click the  icon behind Drawing Setup. The options for the graphical screen are opened. 

 

 
 

2. In the Representation field, choose Filled. 

 
3. The Angle of text is set to 0°. 

 

4. Click [OK] to confirm your input. 
 

5. In the Property Window, click the  button behind Refresh to display the results in the graphical screen. 

 
 

 
6. Then click [Close] to leave the Results Menu. 

 

7. Press <ESC> to cancel the selection. 
 

Note: 

To change the font size of the displayed results, you can use the Setup > Fonts menu.  In this menu, the different sizes of the 

displayed labels can be changed as well as the sizes of any text associated with a specific layer. 
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Code check 

 

The concrete modules of Scia Engineer contain a number of powerful tools to execute concrete calculations in accordance with the 

chosen standard, in this case ACI 318-08. 

The possibilities for calculations include: 

- Input of advanced concrete data 

- Calculation of the slenderness 

- Reduction of M and V at the supports 

- Design calculation of the Theoretically Required Reinforcement 

- Input of the Practical Reinforcement 

In this tutorial, we will only describe the basics of the concrete calculation.  For more information regarding the advanced concrete 

calculations, please refer to the Advanced Training Curriculum. 

Before you can start the concrete calculations, you first must check the buckling parameters of the beams.  By means of the view 

parameters, the buckling lengths of the beams can be displayed on the structure. 

 

Buckling parameters 

Displaying the system lengths 

1. Using the left mouse button, select column B1, the left column of the frame. 
 

2. Click the right mouse button at an arbitrary position in the workspace.  A menu lists the possibilities for the selected entity. 

 

3. In this menu, select the  option. The View parameter settings window appears. 
 

    
 

4. Activate the System lengths and Draw cross-section options to display the reference lengths and the cross section 
shape of the beam. 
 

5. Activate the Local axes – Members 1D option to display the local coordinate system of the beam. 
 

6. Confirm your input with [OK].  

 
7. Press <ESC> to cancel the selection. 
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The figure shows that system length ly for buckling around the strong axis (y-y) is 138 inch while the lz for buckling around the weak 

axis (z-z) is 276 inch. The beam in the middle of the column therefore supports the column for buckling around the strong axis. 

 

To modify the buckling data of a member, use the option Buckling and relative lengths in the Property window of the selected 

member to change the members buckling parameters and relative length. 

Setting the Buckling Parameters 

1. Select both columns with the left mouse button. 
 

2. The Properties window shows the common properties of both entities. The Buckling and relative lengths are set to 
Default. 
 

 

 

3. Click the  icon behind Buckling and relative lengths. The Buckling data window appears. 
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This window shows that the column is supported in the middle for buckling around the strong axis (Y-Y) but not for buckling around 

the weak axis (Z-Z). 

 

4. Click [Edit] to change the buckling data.  The Buckling and relative lengths window appears. 

 

 

 

5. On the Base Settings tab, several data can be changed. 

 
- The Name field contains the name of the buckling parameter, in this case BC1. 

 

- kyy and kzz: in these fields, you can indicate if the program must calculate the buckling factor around the axis 
regarded or if you prefer entering this factor manually.  A third option allows for a manual input of the buckling length.  
The Support option can be used to determine the buckling factor in accordance with the applicable cross section and 

applicable material code. 
 

-  zz: in this field, you can indicate the system length to be used for the weak axis. 

 
- Sway yy and Sway zz: in these fields, you can indicate if the member is braced or not in the direction regarded.  

When you choose the Settings option, the default settings are used. 

Note: 

The default settings for the buckling parameters are displayed in Concrete > 1D member > Setup > Design defaults. By default, 

both directions are unbraced for a concrete calculation. So for example, in a concrete calculation, no wind bracings are assumed. 

 

- def z and def y: in these fields, you can indicate the system length to be used for the relative deformations. 
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6. On the Buckling data tab, you can change the parameters in detail.  As the columns consist of 2 components, 3 positions 

are available: (1) at the beginning, (2) in the center at the floor beam and (3) at the end. 
 
For this project, we assume that the columns are not braced in both directions.  Therefore, the Non-braced property can be 

set to Yes both for the strong and the weak axis. This could also be left on settings, since default settings are sway for 
concrete calculation. 
 

For this project, we also assume that the column is supported in the middle for buckling around the weak axis. The zz 
property at position (2) therefore can be set to Fixed. 
 

               

 

7. Click [OK] to close this window. 

 
8. The Buckling data window re-appears and displays the changed buckling data.  Click [Close] to close this window. 

 

 
 

9. The Properties window indicates that the buckling parameter BC1 is used for the columns in the concrete frame.  
 

10. Press <Esc> to cancel the selection. 
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When the buckling parameters are set, you can continue with the concrete calculations.  Before proceeding, deactivate the 

representation of the View parameters through Quick adaptation of view parameters on the entire construction.  

When the buckling data is adapted, you must recalculate the project.  For these steps, refer to the section of the tutorial concerning 

the Linear calculation. 

Concrete calculation 

Double-click on  in the Main window to open the Concrete menu. 

Displaying the Slenderness and the Buckling Lengths 

1. Click the  icon under the 1D member tree 
 

 
2. The options in the Properties window are configured in the following way: 

 

 The Selection field is set to Current. 
 

 The Load type is set to Combinations and Combination to LRFD - Ultimate. 
 

 The Values are desired for ky, i.e. the slenderness around the yy axis.  
 

 The Extreme field is modified to No. 

 

3. Select column B1, the left column of the frame. 
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4. In the Property Window, click the  button behind Refresh to display the results in the graphical screen in 
accordance with the set options. 

 

5. Change the Values field to luy to display the reference length for buckling around the strong axis. 

 

6. In the Property Window, click the  button behind Refresh to display the new set values. 
 

  

    

 

As already indicated in the buckling parameters, the reference length is 138 inches. 

 

7. Change the Values field to ky*luy/ry to display the buckling length for buckling around the strong axis. 

 

8. In the Property Window, click the  button behind Refresh to display the new set value. 
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Note: 

The calculation of slenderness is important for reinforcement calculation in columns. It will determine whether a second order moment 

has to be taken into account. For a detailed explanation of this, refer to the Advance Concrete Training tutorials. 

Theoretically required reinforcement 

The design of theoretical reinforcement can be found under  in the concrete menu. 

In this tutorial the reinforcement calculation will only be completed and illustrated for the beam B3.  However, it is understood that the 

reinforcement calculation for the other members is similar.  For background on the ACI reinforcement calculations, refer to the 
document, Design of Reinforcement for ACI 318. 

 

Note: 

The calculation procedure for columns is different than for beams. Beams will produce an output for upper and lower reinforcement. 

Column reinforcement is detailing as being on one or both sides, depending on the calculation type which can be uni-axial or bi-axial 

bending. This theory goes beyond the scope of this tutorial, for more information, reference the Design of Reinforcement for ACI 318. 

Longitudinal reinforcement As 

1. In the concrete menu, go to . 

2. Press <Esc> to cancel the selection. 

3. The options in the Property Window are configured in the following way: 

- The Selection field is set to Current. 

- The Type of load is set to Combinations and Combination to LRFD - Ultimate. 

- The Values are wanted for As total req. 

- The Extreme field is changed to Member. 
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4. Select the beam B3 with the left mouse button. 

5. Click the  button behind Refresh to display the results on the graphical screen in accordance with the set options. 

 

 
 

6. Click the  button behind Preview to display the results on the graphical screen in accordance with the set options.  

 

7. Click the  button behind Single Check to display the calculation detailed information. 
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Note: 

- As,req is the theoretically required reinforcement. 

- Reinf.[no.] represents the reinforcement proposal by Scia Engineer (based on the default diameter set in concrete setup) 

- W/E: these are warnings and errors which serve as a guideline to give extra information to the user.  

It is possible during the calculation that also warnings and/or errors appear. If you tick on Calculation info in the property 

window, an explanation of the applicable errors or warnings appear in the preview. The aim of this errors and warnings is to 
give extra information to the user at this point. The most common warnings are about the distance between bars which is 
too big or too small according to the detailing provisions and code. 

Transverse reinforcement Ass 

1. In the concrete menu, go to . 

2. Press <Esc> to cancel the selection. 

3. The options in the Property Window are configured in the following way: 

- The Selection field is set to Current. 

- The Type of load is set to Combinations and Combination to LRFD - Ultimate. 

- Tick on  

- The Values are wanted for Ass. 

- The Extreme field is changed to Section 

 

 

4. Select the beam B3 with the left mouse button. 

5. Click the  button behind Refresh to display the results on the graphical screen in accordance with the set options. 
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6. Click the  button behind Preview to display the results on the graphical screen in accordance with the set options.  
 

 

7. Click the  button behind Single Check to display the calculation detailed information. 

 

Member Data 

Member data can be used to change the settings for each member separately. The settings of the member data have a higher priority 
than the general concrete setup. For instance if you want to change the default diameter for each beam separately, member data 

could be used. 

 

Note: 

It should be noted that even for the calculation of theoretical reinforcement the default diameter is important.  This is because it 

determines the lever arm d which is used for the calculation of As, required. 

 

Member data can also be used to enter basic user reinforcement for the member. 

1. Double-click  in the Concrete Menu. 

2. Select floor beam B3.  

3. The window Concrete 1D Data appears. 
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4. In this window, the concrete properties of the beam can be changed.  For example you can modify the bar diameters, concrete 

coverage, reinforcement material, number of bars and stirrup size and spacing.  In addition, you can define the basic user 

reinforcement for the beam by entering the number of longitudinal bars. 

For this example, enter two #5 bars (.625” DIA) for the upper longitudinal reinforcement and two #6 bars (.75” DIA) for the 

lower longitudinal reinforcement.  Additionally, use #3 stirrups (.375” DIA) at a longitudinal distance of 12” as shear 
reinforcement. 

5. Click [OK] to confirm your input. The concrete data is added to the selected bar. 

6. Press <Esc> to terminate the input. 

7. Press <Esc> once more to cancel the selection. 

Additional reinforcement 

If basic user reinforcement is input on a member, then it is possible to calculate how much reinforcement is additionally required.  

1. In the concrete menu, go to . 

2. Press <Esc> to cancel the selection. 

3. The options in the Property Window are configured in the following way: 

- The Selection field is set to Current. 

- The Type of load is set to Combinations and Combination to LRFD - Ultimate. 

- The Values are wanted for As add.req. 

- The Extreme field is changed to Member. 
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4. Select the beam B3 with the left mouse button. 

5. Click the  button behind Refresh to display the results on the graphical screen in accordance with the set options. 
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Practical reinforcement 

1.     Press <Esc> to cancel the selection. 
 

2. To enter the practical reinforcement desired, you can open the group                                               and next select the  
item   
 

3. Alternatively, you can use the shortcuts in the command line.  Click the   Add reinforcement on whole beam icon.   
 

4. Select floor beam B3 with the left mouse button and when doing so a message box will appear to ask if the basic user 

reinforcement of the concrete beam should be converted into practical reinforcement. 
 

 
 

5. Click [Yes] to accept and proceed. 

6. The stirrup shape manager will appear.  In this window, choose the default StirrupR9 and click [OK]. 

                       

7. The next screen shows two layers of longitudinal reinforcement that are included in the cross section.  The upper layer consists of 

2 #5 bars (.625” DIA) and the bottom layer consists of 2 #6 bars (.75” DIA).  Accept these specifications for the cross section by 
clicking [OK]. 
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8. In previous steps we had calculated that some additional reinforcement was required in the middle of the concrete beam.  

Therefore it is necessary that we add a layer of reinforcement in the zone of the beam from 3’-4” to 16’-8”. 

To enter an additional layer of reinforcement on a selected interval you can either use the                                                                    

icon which can be found in the concrete menu under                                              or use the shortcut in the command line to add 

longitudinal reinforcement on a selected interval       . 

To add longitudinal reinforcement on a selected interval using the shortcut, first select the         icon and then select the beam that 

you want to add the reinforcement too (Beam B3 in this case).  After the beam is selected you have to define the interval.   

To define the interval it is helpful to use snap points on the beam.  To do this, select the cursor snap settings icon          in the 

command line.  In the cursor snap settings menu activate option h) to create 6 snap points on each beam.  Once you do this you 

will now have a snap point at 3’-4” increments along beam B3, now you can select an interval from 3’-4” to 16’-8” along beam B3. 
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9. The next screen shows us the current reinforcement layers in the zone from 3’-4” to 16’-8” along beam B3. 

 

 
 

10. In this screen you can create new layers of reinforcement by using the icons in the bottom left corner of the menu.  In this example 
input the following under New reinforcement parameters: 
 

- Number of bars: 1 

- Size number: 5 

- Stirrup name: S1 

- Edge index: 4 

Once these new parameters are set, click on the                                               icon to create the new reinforcement layer. 
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Once input, practical reinforcement layers are considered additional data.  Since they are additional data, they can be easily copied to 

other beams.  In addition, a reinforcement layers property can be easily viewed and modified by selecting the layer to open the 

property window. 

11. We can now select the layer which contains the stirrups to modify the stirrup spacing. 

a. Select the stirrup Reinforcement Layer by clicking with the left mouse button on the circled number 1           .  

b. Selecting the stirrup Reinforcement Layer will open a Property Window showing the layers properties. 

c. In this example we want to modify the stirrup spacing, to do this click the                  button behind Edit Stirrup 

Distance.  

 

 

 

 

 

 

 

 

 

 

d. The window for Stirrup zones appears. 

e.  Click on the [New Part] button to enter a new section of reinforcement. 

f. Change the input type to distance + total distance. 

g. Change the Distance [in] field for this new section from 12” to 4” and chance Total Distance [in] to 36”. 

h. Under the heading Minimum stirrup reinforcement, change the Distance to begin [in] to 2”. 
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Note that the stirrups are placed closer together at both ends because the sections are automatically defined as Symmetrical.  

     

i. After you are done, click [OK] to confirm your input. 

 

12. The graphical representation of the practical reinforcement can also be modified so that a 3D view of the reinforcement can be 
obtained.  To do this, complete the following steps: 
 

a. Right click anywhere in the workspace. 

b. In the menu that has opened, select the                                                           option.  The window for View parameter 

settings will appear. 
 

c. On the Concrete tab, the data and view options are displayed under the Concrete + reinforcement heading.  Modify the 

view parameters in the following way: 
 

- Set the option Style of stirrups to All. 

- Modify color of reinforcement to read color per diameters. 

- Set the Reinforcement drawing type to 3D. 

- Tick on the Rounded bends option. 

 

 

 

 

 

 

 

 

 

d. Confirm your input by clicking [OK]. 
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After modifying the necessary view settings, a 3D representation of the practical reinforcement is shown. 

 

 

13. It is also possible to show a bill of reinforcement, which would contain a list of all the practical reinforcement on the project as well 

as information like the total length, weight and number of bars.  To view the Bill of reinforcement, selection the icon  

                                         which can be found in the concrete menu.  Once double clicking on the icon, select the Preview button 

in the properties window to display the following table. 

 

 

Note: 

Automatic member design, including reinforcement design could serve as an alternative to manual input of reinforcement  
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Engineering Report 
 
In this final part of the tutorial, the steps for how a calculation package can be set up and the different data sets that can be included 
in the Engineering Report will be discussed. 

Formatting the Report 

1. Double-click  in the Main Window or click  in the button bar. The Engineering Report 
appears. 
 

The Engineering Report will open in a separate window. 
 

2. Click the [Insert] button to show the New Items list.  Each category can be expanded to show additional data types that 

can be added to the report.  Each item can be added by double clicking on the item or using the [+] button.  
 

 
 

3. By means of this window, data can be added to the report. 

 
- Open the Libraries group and double click on Materials.  

- Double Click Cross-Sections.  

- Open the Structure group and double click Members.  

- Open the Results group and double click Internal forces on beam.  

- Also, double click Reactions to add this item to the report. 

 

The items that were added to the report are displayed in the Navigator. Drag or use the move up/down buttons to change the order 

of the items. 

 

Note: For results, the properties table in the Engineering Report functions in the exact same way as it does when viewing results 
graphically.  To see a specific result table, set the properties of the result and click the one of the regenerate buttons. 
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Adding an image to the document 

1. In the graphical interface (window) set the view of the model which you want as a picture in the Engineering Report.   

2. Right click in the workspace and choose Screen shot into Engineering Report or Live Picture into Engineering Report. 
 

 
 

3. The insert window will open with properties that can be set specifically for the image.  Once the settings are set as desired, 

select one of the import options to insert the picture either directly into the report or into the report inbox. 

 

 

Note: The main differences between a Screenshot and Live Picture are that the Live Picture is a dynamic view of the model, meaning 

that if the inputs or results of the model change, the Live Picture will also update automatically.  Additionally, since the image is 

dynamic, users have the opportunity to manipulate the results of the Live Picture using the Edit Picture buttons on the ribbon. 

   

Additional Engineering Report Functionality 

 Modification of Tables 

o Select specific table in Navigator and click “Edit” button.          This enables the user to select and modify specific items in the 
table, change the table layout and also the size and spacing of the table items. 

 Refresh of Engineering Report 

o After adaptations to data or (content of) tables: Red Exclamation Point means item regeneration needed. 

o Regenerate Selected Items  

o Regenerate Outdated Items (Pictures, Tables)  

 Properties of the different components 

o After selection of a component in the Engineering report Navigator, its properties can be consulted and adapted in the 
Properties menu. 

 Combination key: display of governing linear combinations 

o New items > Sets > Combination key 

o Example: Take a look at Internal forces on beam, according to Combinations = ULS; Deformations on beam, according to 
Combinations = SLS. In these tables with results is referred to ULS/1 etc., and SLS/2 etc. The numbers after the combination 

names refer to the Combination key, where the governing linear combinations are written out. 

 Engineering Manager gives you the option to have multiple Engineering Reports in the same Scia file.  You can also have the 

Engineering Report open in the separate window while working in the Scia file.  Any changes made to the Scia file can then be updated 
by regenerating the outdated items (marked by a red exclamation point) in the Engineering Report. 

 The Engineering Report also allows for any information in the “Navigator” to be saved as a report 

template.  These templates are found in the “Report Templates” item in the List of Item.  

 

 

 


